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Logging into your Westpac Share Trading account

You can log into your Westpac Share Trading account using any of the following methods:

Westpac Share Trading login page.
\is

Sign in to Westpac Share Trading

Usemame

] Investing with Westpac
Password Share Trading

l l The trading platform that puts you in control.

‘ Start in: My Home v ‘
> Not a Westpac Share Trading customer? Join Now.
Forgot your password? > Contact Us

There are two ways you can navigate to the Westpac Share Trading login page:

1. Go directly to sharetrading.westpac.com.au/login
2.Go to westpac.com.au and select Westpac Share Trading from the drop down menu in the top right.

Contact us Locate us Lost or stolen cards Register

Home Personal Business Corporate Aboutus Help Online Banking - Personal w Q

Online Banking - Personal
Online Banking - Business
personal > Share Trading Corporate Online

| Westpac Share Trading

,/\ WinTrade

“ Biz Invoice

SHARE TRADING Westpac Digital Connect
View all online services

T
A Westpac Share Trading account gives you
the tools you need to trade smarter.

Once on the login page simply enter your new username as provided in the welcome email sent to you by
Westpac Share Trading. Enter the password you nominated on your account application. If you’ve forgotten your
password you can click on the ‘Forgot your password?’ link to reset your password. If you continue to experience
difficulties logging in to your account please call us on 13 13 31.




Forgotten your password?

If you've forgotten your password or your account is locked due to multiple failed log in attempts, simply navigate
to the login page and click on ‘Forgot your password?’ to reset it.

Username

Password

Start in: My Home v

Forgot your password?

You will be required to enter your Username and registered mobile number. A security code will be sent to your
preferred mobile number via SMS. You will be asked to enter this code online before being prompted to choose a
new password.

Westpac Live Online Banking website.

If you’re an existing Westpac Banking client you can access your Westpac Share Trading account when

logged into the Westpac Online Banking website. While on the Westpac Online Banking home page, look

for the tile named ‘Share Trading (Equity)’ to easily access your Westpac Share Trading account. For your
convenience you will not be required to enter your Westpac Share Trading username and password in the
future following your first log in. If you cannot see the ‘Share Trading (Equity)’ tile please contact us on 13 13 31

Share Trading v
(Equity) 2

1234567

as at 8:54am, 23 Aug 2022

Market valus

$130,572.50

At any time you can navigate back to Westpac Online Banking by clicking on > Return to Westpac Online
Banking located above your Username in the top right corner of the Westpac Share Trading website.

> Return to Westpac Online Banking

1234567 - MR JOHN SAMPLE | & uSERNAME v [RSeRells

If you are not registered for Westpac Online Banking you can register at
banking.westpac.com.au/wbc/banking/registration




Westpac Share Trading mobile app.

You can also access your Westpac Share Trading account on an iPhone or Android smartphone using our
dedicated Westpac Share Trading mobile app. The key features of our app include the ability to view your
portfolio, view live prices including market depth, create watchlists, place trades for Australian shares, warrants
and ETFs, and receive price alerts. You can set up your access using a 4 Digit PIN, Touch ID or Face ID for a quicker
login. The Westpac Share Trading app can be downloaded from the App Store™ and Google Play™.

#_ Download on the
¢ App Store
GETITON

| »’ Google Play

Managing your password.

If you are logged in to the Westpac Share Trading website, you can change your password by going to My
Account > My Profile > Manage Passwords and saving the new password.

Trading Code SMS.

Trading Code SMS is an additional layer of security when placing or amending trades online.
You can opt in to Trading Code SMS online via My Account > Password & Trading Code.

When opted in to the Trading Code, all accounts that you have trade authority on (excluding any Global Markets
Accounts) will require a security SMS code to be sent to your preferred mobile number. This will occur when
placing a new order on an account or amending an existing order.

Client: MR JOHN SAMPLE
Accounts Trading Code will be linked to
> 1234567 - MR JOHN SAMPLE
Preferred Mobile Number:  XOOOO00XXXX
If your preferred mobile needs updating or is incorrect, please update on the ‘Personal Details’ page before opting infout.
Only the preferred mobile number will receive the SMS Trading Code
Opt In for Trading Code: @ves OnNo

*® | acknowledge that | am opting infout of the additional security of Trading Code SMS when placing equity trades on the above
listed accounts. | confirm that my preferred mobile number is up to date.

*Get SMS Security Code: =S VSl The SMS will be sent to 20O000CXX

*Enter the SMS Security Code: |XXXXXX

The SMS will contain a 6 digit code to enter into the designated section on the order review page before
submitting your order to market.

Note: This code is not required when trading through the Westpac Share Trading mobile app. You can opt out at
any time as this service is optional.



How shares are registered

When you purchase shares through Westpac Share Trading, payment for the shares is required two business
days after the trade date. Following your payment, the shares will be transferred and registered in your name

and address, as per the registration details of your share trading account. The ownership of most Australian
securities do not involve paper certificates. Instead, ownership is recorded electronically by each company’s share
registry on their principal register. The principal register is made up of the shares registered on two subregisters,
the subregister sponsored by the share issuer (Issuer Sponsored) and the CHESS subregister (broker sponsored).
CHESS (Clearing House Electronic Subregister System) is operated by the Australian Securities Exchange (ASX
Limited) and requires you to be sponsored by a broker. As a Westpac Share Trading client your shares will be
broker sponsored by the Australian Investment Exchange (AUSIEX) on the CHESS subregister. You will receive a
paper statement for each company shareholding confirming your registered details and the number of shares you
own regardless of whether the shares are Issuer sponsored or broker sponsored.

Broker Sponsored.

Broker sponsored trading accounts will be assigned a single Holder Identification Number (HIN) which starts
with the letter "X

If your holdings are broker sponsored, you will have just one HIN for all your holdings with your sponsoring broker.
If you have more than one broker you will have a separate HIN with each broker.

There are a number of benefits to being broker sponsored by AUSIEX:

* You can easily view all your shareholdings in a single place through your Westpac Share Trading account.

* If you change your name or address there’s no need to notify the share registry of each holding. Simply update
your registered name and/or address of your Westpac Share Trading account and all your broker sponsored
holdings will automatically be updated.

* You can sell shares easily without needing to locate and provide a Security-holder Reference Number unique
to that shareholding.

* Your trading limit with Westpac Share Trading may increase if the value of your sponsored holdings increases.

« If you have a linked Westpac Cash Investment Account you have the option to participate in our Dividend
Direction Service for all your broker sponsored holdings. Our Dividend Direction Service offers the convenience
of your Westpac Cash Investment Account being automatically nominated to receive your dividends. More
details can be found at Contact & Support > Learn & Support > FAQs.

Issuer Sponsored.

Shares you may have acquired along the way, such as through another broker, a share float, or employee

share plan, may be registered on each company’s issuer sponsored subregister rather than CHESS. Each Issuer
Sponsored shareholding is registered with a unique Security-holder Reference Number (SRN) which starts with
the letter ‘I’ or 'S’.

If you hold Issuer Sponsored shares in different companies, you will find that you have a different SRN on each
holding statement.

To sell Issuer Sponsored holdings, you will need to provide Westpac Share Trading with your SRN at the time you
place the order. Orders to sell an issuer sponsored holding will attract an SRN fee of $15 per trade that will be
added to your trade brokerage.

Alternatively, you can transfer your issuer sponsored shares to your broker sponsored account with Westpac
Share Trading.

‘Transferring in’ your existing shareholdings

If you own shares that are not currently broker sponsored by Westpac Share Trading, you can request to
have some or all of these shares transferred to your Westpac Share Trading account as a broker sponsored
CHESS holding.



Issuer to CHESS transfers.

If your shares are issuer sponsored i.e. has an SRN, you can make an online request to transfer these into your
trading account by navigating to My Account > Holdings & Accounts > Transfers.

When ‘transferring in’ Issuer Sponsored shares your registered name and address (including your title/salutation)
for that shareholding must exactly match the CHESS registration details of your Westpac Share Trading account,
otherwise we won’t be able to ‘transfer in’ the shareholding.

To check simply compare your registered details on the Issuer Sponsored holding statement against your
current CHESS registration details with Westpac Share Trading. Your CHESS registration details can be located
on the Transfers page (see below).

Example only:

MR JOHN SAMPLE (HIN: 23456789)

Holdings | Account Details | Transactions @ Transfers

Issuer to CHESS Transfer

To complete an online Issuer to CHESS transfer you will need to provide your Security holder Reference Mumber (SEN). This is
located on the Issuer Sponsored Holding Statement - a letter sent to you by the share registry informing you of the shares you
OWn in a company.
If you do not know your SRM, please contact your Share Reqgistry.

® Important: It is a CHESS requirement that the registration details (name and address) on your Issuer Sponsored

Statement exactly match the registration details (name and address) of your selected account. A match is required
for our system to accept your transfer request.

Please remaove the | from SRMs for the Share Registry "Boardroom’ or they will be rejected.

Account Details

Account | 1234567 - MR JOHM SAMPLE

HIN 23456739

CHESS Details

Name If-.-'IR JOHM SAMPLE I

Update Name

Address |BB SMITH STREET, SAMPLETOWMN N3W 2999'
Update Address
Update Address Online

If there are any discrepancies between your CHESS and issuer sponsored registration details, we recommend you
update them with the share registry or Westpac Share Trading prior to attempting the transfer.

To request an ‘Issuer to CHESS transfer’ simply enter the ASX code, SRN and number of shares/units you wish
to transfer.



Example only:

Enter the SRN details (?)

|ssuer Sponsored Securities

BHP 100099999999 100 x

For transfers to be successful, the shareholder name (including salutation) and address on the statement must match the
CHESS details above. This transfer reguest will be manually verified by our team with the share reaqistry.

To add additional shareholdings click on ° and enter the required security details.

Click on Proceed to submit your transfer request. Westpac Share Trading will confirm each shareholding
with the relevant share registry before initiating the transfer of your shares.

Broker to broker transfers.

If your existing shares are currently broker/CHESS sponsored with a broker other than Westpac Share Trading,
you can request to have some or all of them transferred to your Westpac Share Trading account.

If your request is for all your shares to be transferred from the existing broker we may arrange for the HIN

and all the shareholdings within to be transferred to AUSIEX. This means you will keep your existing HIN, however
the sponsor of that HIN will change to Westpac Share Trading. All your existing TFN, dividend and bank account
details with each share registry will remain unchanged.

If your request is to transfer only some of your shares, your existing HIN will remain with the existing broker. Only
those shares you have requested will be transferred into your HIN with Westpac Share Trading. In this case you will
have two HINs, one sponsored by your existing broker and one sponsored by AUSIEX.

To transfer broker/CHESS sponsored shares with another broker to your Westpac Share Trading account please
complete and return a Share Transfer form.

You will need to provide your existing broker’s CHESS Participant Identifier (PID) and your HIN with the broker.
This information can be easily located from a CHESS holding statement of a security currently sponsored
by the existing broker.
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Example only: CHESS holding statement.

Company logo and name

i CHESS HOLDING STATEMENTI

For statement enquiries contact
your CHESS Sponsor:

Your sponsoring broker's
name and address

Your name and address
as registered in CHESS

Holder ID Number (HIN}:  Your HIN

CHESS Sponsar's ID(PID): 5 digits

Statement Perioa;

Page: 1of1
AsX code - ORDINARY FULLY PAID
Date Transaction Type Transaction ID  Ex/Cum Quantity Holding
Status On Off Balance
Balance Brought Forward from
Date Transaction description Number of
units held

FOR YOUR INFORMATION

w-To obtain full terms and conditions of an Issuer's securities contact the Issuer's Registrar or the Issuer directly.
w-For information about CHESS Depositary Interests (CDIs) and to obtain a free copy of the Financial Services Guide

(FSG) or any supplementary FSG for CHESS Depositary Nominees Pty Ltd go to www.asx.com.au/cdis or phone 131 279.
wASX Settlement may by law need to disclose information in CHESS Holdings to third parties.
Do you have a small shareholding? Donate to Australian charities using ShareGift's

brokerage-free service & receive tax deduction when over $2. www.sharegiftaustralia.org.au

Refer overleaf for additional important information

Share Registry Details:

Share registry name
and address

ASX Issued By:

ASX Settlement Pty Limited | ABN 49 008 504 532 | PO Box H227, Australia Square, Sydney NSW 1215

Please note that once your requested shares have been transferred to your Westpac Share Trading account you
will receive a new CHESS holding statement for that security at the end of the month. Shares that are broker
sponsored by Westpac Share Trading will show Australian Investment Exchange Ltd as your new CHESS sponsor.

mn



Your CHESS Holdings

You can view your broker sponsored holdings by navigating to My Account > My Portfolio > Holdings & Accounts
and clicking on the Holdings tab.

Here you can also manually enter your issuer sponsored shares, and managed funds, to see a more complete
picture of your investment portfolio.

Example only: Holdings page with CHESS and Issuer Sponsored shareholdings.

Holdings =~ Account Details | Transactions | Transfers

Share Holdings Download CSV | Edit | Add Issuer Holding Thu 18 Aug 2022 11:45 AM (Sydney time)
Change  Change
Available Reserved Purchase Last Market Erofit / Loss Profit / (Today) (Today)
Code v Units Units Price{5) Price{$) Value($s) Value($) Loss(%) Price($) Value(S) g Actions
CHESS
There are no CHESS holdings on this account. Transfer Shares

*  Add holdings by placing_a BUY order

Issuer

BEN 2,000 8.550 9.690  19,380.00 +2280.000  +13.33  +0.080  +160.00 E s
BHP 500 35750 41400  20,550.00 +2675.00  +1497  +0.250  +125.00 [ E3
IAG 1,300 6.000 4.570 5,941.00 -1,859.00 2383 0080 10400 B E s
RMD 750 12930 33920  25440.00 +15,74250) +162.34  0.130 -97.50 E3
svw 500 19500  18.280 9,140.00 -610.00 626 +0.070)  +35.00 El
TLS 2,850 3500 4.095 11,670.75 +169575 <1700  +0.005 ~ +14.25 E s
WOW 1,000 26820 30350  39,350.00 +12530.00  +4672  -0.040 -40.00 [ sei ]
Subtotal 131,471.75 +32454.25  +3278 +92.75

Total 131,471.75 +32454.25  +3278 +02.75

You can also view the composition of your share portfolio in pie charts, broken down by security and market
sector.

Example only:

Share Holdings Summary Chart - CHESS and Issuer Sponsored

Shares in your portfolio Sectors in your portfolio
I BENM (14.72%) B Firzncisls {13.229%)
BHF (15.60%) Materizls (15.80%)

B Hesith Cars (19.40%)

Il |rdustrisks (8.35%)
Communication Servi... (8.88%)

Il Conswmner Staple (28.55%)

I (AG (4.50%)

I RO (15.40%)
SV (6.95%)

N TLS(3.83%)
WO (29.95%)

12



Updating your personal and trading account details

Your personal profile which consists of the following details can be updated online by navigating
to My Account > My Profile > Personal Details.

* Residential address

* Postal address

» Contact phone numbers

* Email addresses

* Promotional information preference

» Settlement notification preference

If you update your postal address and you are the primary party of a single individual and/or joint individuals
trading account, then the registered CHESS address of your single individual and/or joint individuals trading
accounts will also be updated.

If you are a director of a company or company trust trading account, updating your personal profile will not
update the address details of the company trading account. To update the addresses of a company or company
trust account please complete and return a Change of Address form.

Customising your home page

When logged in, the homepage makes it easier for you to customise and manage your portfolio to best suit you.

Your homepage pulls together all the features you have told us are important to you, including the ability to view
your portfolio/s, manage your watchlist/s, keep track of upcoming settlements, monitor market insights and
more - all on the one page.

We appreciate that not all customers are the same, so you can now personalise your homepage by adding, removing,
and duplicating sections.

Widgets available to you:
Stock Quote or Search - Navigate quickly through the website or get a quote for a stock.

Share holdings - Quick view of your CHESS holdings and performance for all your accounts. Using the default tick
box, you can set your most viewed account.

Watchlists - Set up watchlists to track stocks and their performance. You can have 20 watchlists and set your
default to your favourite at the time.

Market Watch - Quick view of stock movements based off 7 filters including “Top stocks by % rise’ and ‘Top stocks
by $ fall’.

Daily Market Updates - Snapshot summary of the ASX and World Markets provided by Morningstar.

Estimated Settlements - Shows the upcoming estimated settlements on your trading accounts. It will include the
date of settlement and estimated amount that will be debited or credited. This calculation is updated throughout the
day to accommodate for any offset buys/sells.

Most Popular Stocks - Quick view of the top 5 stocks bought and sold through Westpac Share Trading for the
trade day.

Market Indices - Overview of the value and change for 5 different Market Indices.
News Feed - View the most recent market news and research articles.
Site News - Important information regarding updates or changes to our platform, service and offering.

Currency Exchange Rates - Compare the AUD against the value of 5 other currencies.

13



To change the widgets on your homepage, select the ‘Manage’ button and choose the widgets you'd like to
appear on the left column (wide) or the right column (narrow) and select ‘Save Locations’.

\\J
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Left Column (Wide)

1

Home My Account Watchlists Quotes & Research

Trading Products & Services  Contact & Support

Q Quick Quote or Search

Right Column (Narrow)

Share Holdings 1
Watchlist 2
Market Watch 3
Daily Market Updates 4:
None 5
None 6

Reset to Defaults

Estimated Settlements v

Most Popular Stocks v

Market Indices v
News Feed v
Site News v
Exchange Rates v

Cancel EEEVEIE ez 1



Securities that can be traded

Westpac Share Trading offers access to a range of securities that are listed on the ASX and Cboe securities

exchanges. They include:

* Listed shares

* Listed warrants

* Listed fixed interest securities

* Listed government and corporate bonds
* Exchange Trade Funds (ETFs)

* Exchange Traded Commodities (ETCs)

* Exchange Traded Options (ETOs) - you will be required to apply for an Options trading account

* Listed company-issued options
* Listed unit trusts

¢ Listed convertible notes

* Renounceable rights

You can also access equities in 26 international exchanges through Westpac Share Trading®. To trade international
shares you will be required to apply for a Global Markets Trading account.

For more information about the various securities and products available, go to Products & Services.

* Global Markets trading is provided by Pershing LLC, ARBN: 108 110 149, AFSL no 271837, member FINRA, NYSE,

SIPC through Australian Investment Exchange Ltd (“The Participant”) ABN 71076 515 930 AFSL 241400, a

Participant of the ASX Group.

\I’ Home My Account Watchlists Quotes & Research  Trading  Products & Services  Contact & Support
> Trading Platforms » Trading Tools > Shares > Derivatives > Cash & Lending
Standard - Live Pricing Mews & Research Australian Shares Opfions Cash Invesiment
Account
Advanced - Dynamic Charting International Shares Warrants
Pricing Margin Lending
Trading Alerts IPOs

Mobile Investing
Conditional Trading ETFs & ETCs

Government Bonds

Ways you can trade

Online.

Log in to your trading account at sharetrading.westpac.com.au and navigate

to Trading > Share Orders > Place Order.

Mobile app.

Log in to your trading account using the Westpac Share Trading mobile app and navigate to More > Trade.

Over the phone.

If you don’t have access to the internet or a smartphone, you can call Westpac Share Trading on 13 13 31

and we’ll place the trade on your behalf.

Please note: Brokerage rates will vary depending on whether a trade is placed online or over the phone.

For a list of our brokerage rates please refer to the brokerage rates table in our Financial Services Guide.

15



How to place an online order

To trade online, go to Trading > Share Orders > Place Order.

Home My Account Watchlists Quotes & Research  Trading

2> Share Orders » Conditional Orders 2> Options Orders
FPlace Crder Flace Crder Ciptions Series
Manage Orders Manage Orders Flace Crder
Confirmations Manage Orders

CDptions Statements

You can also place a trade from your watchlists and company research pages where you see the Buy and Sell
buttons or links.

The online order pad will be displayed and will require the following inputs:

Example only:

*Required Fields

@) Account: 1234557 - JOHN SAMPLE
@ ©: Order Type: @ BUY
() SELL
@ O+ Code: Q. BHP GROUP LIMITED FPO (ORDINARY FULLY
PAID)
® © - Quantity: or Value($): | |
@  O-price Limit ($): or [] At Market
@ © “Expiry: g or (] Good for Day
Order Value (3): 4,120.000
Brokerage & Cost (3): 19.950 (Includes GST)
Total (§): __ 4,139.950

As at 05:38 PM Monday, 22 August 2022 (Sydney fime)
Estimate Cnly. Price may vary significantly

(6

16



® e

Select the BUY or SELL order type.

Enter the security code. If you don’t know the code enter the security name and click @ to search and select
the required security from the list of search results.

©® Enter the quantity of shares or the maximum value you wish to buy or sell. If you enter a dollar value we will

e

(6]

calculate the maximum number of shares that will result in your order not exceeding the amount you have
entered.

Enter the price limit per share you wish to buy or sell at. Alternatively, select At Market if you wish to trade
immediately at the prevailing market price. Please note: At Market orders can only be placed during market
hours (between 10am and 4pm Sydney time on trading days).

Select your order expiry date (up to 21 calendar days) or select Good for Day if you would like your order
cancelled at the end of the trading day if not filled.

Click on Proceed and review your order.

Example only:

Details of your order instruction are shown below for your approval and confirmation.

7]
8]
9]

@ Account: 1234567 - MR JOHN SAMPLE
Order Type: BUY
Code: BHP

Description: BHP GROUP LIMITED FPO (ORDINARY FULLY PAID})
Quantity: 100
Price Limit ($): At Limit (40.000)
Expiry: Good Until Expiry (12/09/2022)

Order Value ($): 4,000.000
Brokerage ($): 18.140 (Excludes GST)

GST ($): 1.810

Total ($): 4,019.950

As at 09:51 AM Tuesday, 23 August 2022 (Sydney time)
(8] (5 ) 9

Review the details of your order instruction.
If you wish to amend or cancel your order click Change or Cancel.

Click Submit Order to confirm and place your order.

17



Managing your orders

At any time you can review, amend and cancel any of your open orders. Open orders are orders currently in the
market that are unfilled or partially filled. If you cannot locate an open order to amend or cancel, your order may
already have been executed in which case you will not be able to make any changes and you will need to ensure
that you have sufficient funds or shares, as relevant, to settle the order.

Navigate to Trading > Share Orders > Manage Orders from the top navigation menu.

Home My Account Watchlists Quotes & Research  Trading

2> Share Orders » Conditional Orders » Options Orders
Flace Qrder Flace Order Options Series
Manage Orders Manage Orders Flace Qrder
Confirmations Manage Orders

Select Outstanding Orders from the View dropdown list and click Display.

Trading » Share Orders » Manage Orders | - ‘ ‘Q Quick Quote

Manage Orders - Australian Shares

*Required Fields
(®  *Account: 1234587 - MR JOHN SAMPLE v

View: | Qutstanding Orders v

Outstanding Orders

Cancelled Orders v

Advanced Search
Executed Orders

Amending an open order.

Once you have found your order under Action on the right hand side select Amend. A prefilled order pad will

be displayed allowing you to increase or decrease the total quantity, amend the At Limit price or Order Duration.
Once you’ve made your changes simply click Proceed, review the changes and then click Amend Order.
Example only:

Order Date | Time » Order Number Order Type Code Quantity Ordered Quantity OQutstanding Quantity Executed Price (§) Expiry Date Status Actions

231082022 951 AM  ZGJPX-W Buy BHP 100 100 0 40.000 12/09/2022  Open

1 result found > View I

. . . - ) ) ) ) ) ) ) , . J > Amend |
Infermation on this page is pericdically archived. Depending on your frading volume, you will be able to view up to 2 months order history. All holdings. financial transactions and confi

be accessed from the Portfolio section. If you require a copy of your archived order history, contact us. » Cancel

18



Amend Order

Account:

Crder Type:

Code:
Description:

Price Limit {§):
Quantity Ordered:

Quantity Executed:

Expiry:

Amendments

@ *Expiry:
@ *Quantity Ordered:
@) *Price Limit ($):
Order Value {%):

Brokerage & Cost (%)

Total ($):

Clear

1234567 -MR JOHN SAMPLE
BUY
BHP

EHP GROUP LIMITED FFO (ORDINARY FULLY PAID)

At Limit (40.000)
100
0

Good until expiry (12/09/2022)

12/08/2022 g or [_| Good for Day

[100 |
[29.500] | or [] AtMarket
3,950,000
19950  {Includes GST)
3,969,950

As at 10:03 AM Tuesday, 23 August 2022 (Sydney time)
Estimate Only. Price may vary significantly.

~

*Required Fields

Cancel Proceed

19



Cancelling an open order.

Under Action select Cancel. A summary of the order will be displayed. Select Cancel order at the bottom of the
page. You will receive a notification if the request has been successful.

Example only:

) Order Order Quantity Quantity Quantity . Expiry .
Order Date / Time ~ Number Type Code Ordered Qutstanding Eemin Price (§) Date Status  Actions
22/08/2022 5:51 PM ZGGWN-W Buy BHP 100 100 0 40.000 12/092022 | Review [Efsnoeey
I result found > View ;
: . : . ) : . i _ > Amend
nformation on this page is periodically archived. Depending on your trading volume, you will be able to view up to 2 months arder history. AN holdings, financial transactions and confirm
e acocessed from the Portfolio section. If you require a copy of your archived order history. contact us. I > Cancel I

Example only:

Cancel Order

If this cancellation instruction is received outside of ASX market hours while a previous accepied
amendment instruction has not been processed, this cancellation instruction will take effect on the
unprocessed amendment and not your original order. Should you wish to cancel your original order, submit
your current instruction and return to the Manage Orders page and cancel the original order.

® Your order will be cancelled.

Account:

Order Type:
Code:
Description:

Price Limit ($):
Quantity Ordered:

Expiry:

6617925 - ML - MR DARRYL BOW

BUY

BHP

BHF GROUP LIMITED FPO (ORDINARY FULLY PAID)
At Limit (40.000)

100

Good until expiry (12/09/2022)

To proceed with this instruction please check all details carefully and select "Cancel Order’. Note that this instruction will be actioned on the market only when trading in the

security is open.
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Order Confirmation Notes

You will be provided an order confirmation note for each executed trade. The confirmation note provides all details
of the executed trade and should be retained for your records. Confirmation notes will be sent to you by email or
post, depending on your nominated preference. Please note that posted paper order confirmations attract a $2.00
fee per confirmation note. Confirmation notes sent to you via email (up to six email addresses) are provided at no
cost. You can update your confirmation note preference by navigating to My Account > My Portfolio > Holdings &
Accounts, clicking on the Account Details tab and locating the Confirmations section.

Confirmations
You will be charged 32.00 per paper Confirmation.

Receive the original confirmation by email and up to five copies (Mote: this is a free service).

@ Original Confirmation Preference: @ Email
() Paper

Free Trading Tools and Research

The Westpac Share Trading platform provides a comprehensive range of free trading tools designed to suit most
traders and investors. To complement these tools we also provide you with Morningstar investment research which
includes detailed analysis of markets, sectors and companies, forecasts and stock recommendations.

To assist you with your trading, Westpac Share Trading offers:

* Live Pricing - including market depth across Australian shares, ETFs, options and warrants;

* Watchlists - you can keep an eye on stocks you are interested in by setting up personal watchlists;

« Alerts - we’ll watch the market for you and let you know if a stock trades at a certain price;

» Easy to use trading tools - including key company metrics, dividends, historical prices and advanced charting;

* The latest news feeds - providing company announcements, pre-market, intra-day and post-market
commentary including video reports

* Research and recommendations - from Morningstar, providing detailed analysis of markets, sectors
and companies, including forecasts and stock recommendations.
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Live pricing.
There are two ways to view the current price of a security:

© You can quickly and easily obtain a price quote by using the Quick Quote search feature found in the top right
corner of most pages on our site. Simply enter the ASX code or security name to start searching.

‘ Q Quick Quote

® Click on the Quotes & Research navigation menu and select Quotes.

Home My Account Watchlists Quotes & Research  Trading Products & Services

> Research > Quotes > Tools

Markets Quotes Interactive Charting

Sectors End of Day Prices Trading Ideas

Company Company Search Stock Screener
Market Watch ETF Screener
Market Indices Upcoming Dividends
Daily Market Update Company

Announcements

Westpac Insights

Enter the ASX code or security name to find all related securities. Click on the required security to view.

You are here: Quotes & Research = Quotes

Quotes

Quotes & Depth Course Of Sales Option Series

Code:

ex}
xI
Y

|
A8 Display
H

P GROUP LIMITED FPO (ORDINARY _..

(L)
0

[us]
als

00
.

PDO2
CITIWARRANTS (CGMA) DEF SET (CT...

' BHPDOB
CITIWARRANTS (CGMA) DEF SET (CT...

EHPDOC
| CITIWARRANTS (CGMA) DEF SET (CT...

— -
Find Code(_ 3
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The last traded price of the security will be displayed together with its Market Depth. The Market Depth shows
a summary of all buy and sell orders that are currently queued in the market, allowing you to see the number
of shares and the maximum and minimum prices buyers and sellers are prepared to pay or sell their shares.

Example only:

Quotes & Research » Quotes l p— ‘ lQ Quick Quote

Quotes

Quotes & Depth Course Of Sales Option Series Announcements Company Research Trade History Charts

Code: 'ﬂx Display

() Open in new window

BHP $37.080 w $-0.580 (-1.54%) Add to Watchlist | Add to Alerts | Manage Orders
BHP GROUP LIMITED FPO (ORDINARY FULLY PAID) Thu 28 Oct 2021 3:09 PM (Sydney time)

Date Range: 1d | 5d | 1m | 1y | 3y
Share Quote

50
Bid ($) Offer ($) High ($) Low ($) Volume Trades Value ($) Open ($) Previous Close ($)
37.080 37.090 37.600 37.060 3,554,647 24,934 132,512,968 37.330 37.660
30
Market Depth View: Price Detail | Order Detail Jan  Apr Jul Oct
Volume
20M
Buyers Sellers
10M
No. Volume Price ($) Price ($) Volume No. oM
24 7,764 37.080 37.090 222 5
g Share Details
14 8,460 37.070 37.100 4,394 25
52 Week High ($) 54 550
15 6,939 37.060 37.110 4,835 16
52 Week Low ($) 33.730
20 6,249 37.050 37.120 2,742 11
Last Traded 28M10/2021
8 2,035 37.040 37.130 2,686 8 3:09:44 PM
10 5,044 37.030 37.140 3,487 10 Trading Status Normal
10 6,682 37.020 37.150 2,899 12 Market Status Normal
26 12,504 37.010 37.160 2295 10
371 133,584 37.000 37.170 1,860 8 Market Indices
8 3,766 36.990 37.180 2984 6 Teris Value Change
3,008 buyers for 1,181,415 units 1,150 sellers for 999,700 units -
Ordinaries 7,729.300 -28.700

- AV DI

On this page you can also view other price information. Click on the tabs labelled:
Course of Sales to view a detailed list of all individual trades executed for this security today.
Trade History to view the daily open, high, low, close price and traded volume over the past 12 months.

Options Series to view the available exchange traded options and their current quotes.
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Watchlists.

You can easily keep track of all stocks you are interested in by creating watchlists. You can create an unlimited
number of watchlists. To get started simply click on the Watchlists navigation menu.

Home My Account Watchlists Quotes & Research  Trading Products & Services  Contact & Support

> Watchlists > Portfolio Tool > Alerts

Create Portfolio View Alerts

To create a watchlist click on ‘Add Watchlist’.

Example only:

View Watchlists

€) Trade from $19.95 with a Westpac Cash Investment Account.

Watchlists: | Watchlisti v |

View: Shares | Portfolio | Options

Add Watchlist ) Settings | Group Watchlists

To add stocks to your watchlist simply enter the security code and click ‘Add’.

Wed 12 Jun 2019 3:36 PM (Sydney time)

Code: | | Q @

Click on ‘Edit’ to give your watchlist a name, to add or remove stocks, or to add the purchase details of any stock
you already own.

Example only:

Mining stocks Wed 12 Jun 2019 3:39 PM (Sydney time)
Delete | Download | Launch Market Map 7 | Refresh Code: _\ OW Add
Code Bid (§) Offer($) Last($) Change ($) (%) Open($) High($) Low($) Volume Actions

a BHP 39.800 39.810 39.805 +1.105 +2.86 39.370 39.830 39.370 4,812,497 Buy | Sell [
-~ RIO 102.620 102.630 102.620 +2.070 +2.06 102.100 103.000 101.830 1,107,445 Buy | Sell u
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Alerts.

To complement your watchlists we’'ve created free and unlimited price alerts that can notify you when a stock
has risen above or fallen below a certain price. You can even set up dividend and company announcement alerts.
Alerts can be received via push notifications on your smartphone and via email.

To create an alert simply click on ‘View Alerts’.

Home My Account Watchlists Quotes & Research  Trading Products & Services  Contact & Support

> Watchlists > Portfolio Tool > Alerts

View Watchlists Create Portfolio

Click the Create tab as per below, enter the code or security name, the alert type, the trigger price and your
notification delivery preference. Click ‘Add Alert’ to activate your alert.

Create Manage History About

Create New Alert Form

Select a company: Select an alert type: Enter trigger price: Select delivery method(s):
BHP Group Ltd Price Rises Above v 40.00 [#| Push Notification ¥ Email

An alert will be sent when the stock price rises above a specified
value. Please enter a trigger price that is above the current value of
this stock.

Please note: In order to receive push nofifications, you must have the latest Westpac Online Investing app installed on your smartphone. Add Alert
Email notifications will be delivered to your preferred email address, which can be found in the My Profile section.

Company Information.

To find a range of information about a particular company navigate to Quotes & Research > Research > Company.

Home My Account

Quotes & Research

Trading  Products & Services

> Research > Quotes > Tools

Markets Quotes Interactive Charting
Sectors End of Day Prices Trading Ideas
Company Company Search Stock Screener

Market Watch
Market Indices

Daily Market Update

ETF Screener
Upcoming Dividends

Company
Announcements

Westpac Insights
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Enter the company code or name in the search field to view a summary of the security.

Example only:

- Bearch by name or code for Security Research ] o I T I

Last Price Today's Change
BHP Group Ltd &) $37.020 ¥ -0.640 (-1.70%)
Share: Materials / Materials As of 28 Oct 2021, 4:10pm AEDT. (Dala sourced from ASX TradeMatch only.)
; . s ) Open (§) 37.330
Bid / Size 37.010/ 5,880 52 Week High 54.550
v . : High (5) 37.600
Offer | Size 37.040 /47,000 52 Week Low 33.730
6,141,262 sgrozor b
Voume R Last Traded !

----------------- 16:10:41 PM Previously Closed ($) 37.660

Announcements Charting Dividends E‘ggﬁ;m% About % Trading_Ideas Financials Derivatives

On this page you will find a variety of options that will allow you to view the latest company announcements,
advanced charts, dividend history, research and recommendations, forecasts, and the latest financials.

Current Stock Recommendations.

Our trading platform provides you with Morningstar investment research which includes their latest stock
recommendations.

To see Morningstar’s current recommendations for a security click on the Trading Ideas tab located under
Quotes & Research > Research > Company.

Example only.

Summary Announcements Charting Dividends gg&%’%m About % Trading Ideas Financials Derivatives
Overview Company Comparison
Morningstar™ Premium o Morningstar™ Quantitative [} Consensus Recommendation (i ]
Recommendation @ Recommendation @
Hold on 19/08/2021 Undervalued on 21092021 Moderate Buy on 05102020
Previously Reduce on 18/08/2021 Previously Fairly Valued on 02/09/2021 Previously Hold on 08/07/2020
5$100.000 $60.000 $60.000
W 50,000 M Py w 2
[0 O 00 < I . Gl I [ [ 1 ] [ [ N S
2008 203 2018 2m7 2018 2018 2020 2021 2010 2012 2014 2016 2018 2020
»_Go to full recommendation » Go to full recommendation »_Go to full recommendation]|

There are three types of stock recommendations - Morningstar Premium, Morningstar Quantitative and Consensus.
Morningstar Quantitative Recommendations are generated by a statistical model that is based on Morningstar’s
analyst-driven equity ratings and quantitative statistics. Consensus Recommendations provides a view of the
recommendations made by various brokers and research houses. Both Morningstar Quantitative and Consensus
Recommendations are available at no cost to all customers.

To view the details of the recommendation simply click on Go to full recommendation. Here you can download
Morningstar’s reports and see their star rating and fair value estimate for the security.
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Recent Morningstar™ Recommendations

Recommendation
Recommendation Date Report

B Undervalued 261012021 (Download .+
Current

Key Quantitative Values 26/10/2021

Quantitative Morningstar™ Rating

g

Fair Value Estimate

(i
$ 41.78 aup

Morningstar Premium is designed for investors looking for more detailed information and is available by
subscription. Morningstar Premium offers analyst recommendations for a wide selection of companies.
Morningstar Premium provides in depth analysis, forecasts, detailed commentary by Morningstar’s analysts on why
a recommendation has been made, and access to a range of sophisticated tools including Morningstar’s Model
Portfolio Tool. A Morningstar Premium subscription costs $20 per month, however will be fully rebated if you settle
two or more trades or pay $50 or more in brokerage in the same month.

To subscribe to Morningstar Premium, simply click on the Subscribe Now button or navigate to
My Account > My Profile > Alerts & Subscriptions, and locate Advanced Package.

Advanced Package

Upgrade to the Advanced Package and receive Morningstar Premium Research ($20 per month including GST. Rebate available for active
traders).

Monthly Cost: $20.00

27



Stock Screener

Stock Screener is an advanced research tool that can help you build a portfolio of stocks that meet your
investment goals. No matter whether you’re looking for yield, growth or value stocks, Stock Screener will help you
find them using its pre-defined and custom search options.

To get started navigate to Quotes & Research > Tools > Stock Screener.

Home My Account Watchlists Quotes & Research  Trading Products & Services

> Research > Quotes > Tools

Markets Quotes Interactive Charting

Sectors End of Day Prices Trading Ideas

Company Company Search Stock Screener
Market Watch ETF Screener
Market Indices Upcoming Dividends
Daily Market Update Company

Announcements

Westpac Insights

Pre-defined Screens.

Our pre-defined screens will help you find stocks using pre-set criteria and parameters. Select Stock Screener’s
Predefined Screens.

Pre-defined Screens Custom Screener

Select the Strategy Goal that best suits your investing goals. For example select:

Growth - to find stocks with capital growth potential based on consistent earnings growth
Value - to find stocks that may be undervalued i.e. Price to Earnings ratio below the market average.
Yield - to find stocks with a dividend yield greater than the market yield (stocks in the ASX All Ordinaries index).

Once you've selected your Strategy Goal, select your preferred Pre-defined screen. Each Pre-defined screen uses
a number of pre-set criteria and parameters.

Strategy Goal: Strategy Goal: Strategy Goal:
Growth v | | Value v | | Yield v
Pre-defined Screens: Pre-defined Screens: Pre-defined Screens:
v Affordable Quality Growth +" Undervalued Stocks +" Blue Chip Income Stocks
Undervalued Growth Stocks Undervalued Stocks Relative to H. .. Cyclical Income Stocks

Undervalued Growth Stocks

Once you select a pre-defined screen, the stocks that meet the pre-set criteria will be displayed on the page.

You can then change the displayed results by clicking on View by dropdown menu. You can also sort your results
in ascending and descending order by clicking on the triangle that appears beside any of the column headings
(see next page).
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Example only:

Search for stocks

Select from a set of pre-defined screens
to help find equities that may match your
investing goals.

Strategy Goal:
Yield v

Pre-defined Screens:
Blue Chip Income Stocks \

Custom Screener.

30 Results View b@ )

1 Year

Div. Div.

j Current Payout Growth

A~ Yiel Div. & Ratio a Franking a Rate a
12.70% $0.20 98.00% 100.00% 85.80%

6.70% $0.83 85.00% 100.00% 0.00%

6.70% $0.94 81.00% 100.00% 0.00%

6.50% $0.60 62.00% 100.00% -47.50%

You can also customise your stock search by setting your own search criteria using any combination of the 47

search criteria available.

Simply click on Custom Screener and then the Add More Criteria button.

Select Screener Criteria

Add More Criteria

Select each criteria you would like to use to filter your search and then click the Close button.

Additional Criteria X

Base Criteria:
Market Cap

¥/ Sector
Price
Options Available

Warrants Available

Dividends:
¢! Dividend Yield (%)
Current Dividend

Performance vs ASX200:

Price Performance compared to the
ASX200

Beta

Performance vs Sector:

Price Performance compared to the
company's Sector

Technicals:

Moving Average Crosses
Price vs. 10 day SMA
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Your selected criteria will now appear down the left side of the page. You can then further customise your search
by adjusting the parameters of each criteria. For example in the example on the next page, you can just select
those sectors you are interested in and you can select the range for other criteria by simply adjusting the minimum
and maximum values or moving the red sliders.

B Base Criteria:

Sector X

Communication Services
Consumer Discretionary
v’ Consumer Staples
Energy
v’ Financials
v’ Healthcare
v Industrials
v Information Technology
v’ Materials
Real Estate
v’ Utilities

B Dividends:
Dividend Yield (%) x

T T

B Valuation:

Price-Earnings Ratio (P/E) x

8.76. § § 26.80
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Customer Support
Learn & Support.

Westpac Share Trading is committed to supporting both new and experienced investors and has developed
Education Hub. Education Hub is an invaluable resource that will help you learn more about the Australian
sharemarket. It also provides various guides and videos to help you navigate and take advantage of the many
features offered within the Westpac Share Trading platform. Education Hub can be found in the Contacts and

Support menu under Learn & Support.

Quotes & Research  Trading

» Contact Us

Products & Services

> Forms

Contact & Support

» Learn & Support

General Enquiries
Technical Support
Forgotten Password
Complaint Resolution
Privacy Policy

Site Map

Download Forms

Education Hub

Webinars

FAQs

Resources

Site Mews

Education Hub

Learning and Resources

Webinars

and previous Wehinars.

> Watch the webinars

ol

Westpac Insights

Our in-depth resource hub, keeping you up to speed
with the latest economic and financial market news
and updates.

Access our Trading and Research Video Tutorials

Resources

Articles, user guides and videos to help you learn more abou
the Share Market and your Westpac Share Trading account.

> Check our resources

FAQs

Looking for answers to your general Share Trading enquiries,

visit our FAQs page.

> Get some answers

B

Forms

If you need to update your details, transfer shares,
access various Westpac Share Trading applications
or simply view important documents.

t

N

Site News

View the latest announcements relating to site
upgrades and new features, as well as topical market
and regulatory news.
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Frequently Asked Questions.

If you can’t find what you’re looking for here, you can also visit our FAQs page which covers a comprehensive

range of topics.

& Research  Trading  Products & Services  Contact & Support

» Contact Us » Forms » Learn & Support
General Enquiries Download Forms Education Hub
Technical Support ‘Webinars
Forgotten Password FAQs
Complaint Resolution Resources
Privacy Policy Site News
Site Map
Contact & Support » Learn & Support » FAQs
All Categories
Getting Started Dividend Direction Service Research
My Account Trader Pro technical Rewards

Clear Search

Getting Started

How do | trade with Westpac Share Trading?

What is the difference between CHESS sponsored and Issuer Sponsored?

Will my orders go straight through to the market?

What type of orders can | place?

ECFY Statements

Financial Difficulty

|1 <<€

For more details, refer to ‘Terms and Conditions’ and ‘Westpac Cash Investment Account Terms and Conditions’

located on the homepage.
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Still didn’t find what you’re looking for?

Help is never far away. If you have a question or require assistance with any aspect of our trading platform please
contact the Westpac Share Trading customer service team.

We’re here to help

\ 131331
8am to 7pm (Sydney time) Monday to Friday

securities@westpac.com.au
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We’re here to help

\ 1313 31
8am to 7pm (Sydney time)
Monday to Friday

securities@westpac.com.au

Things you should know:This information has been prepared by Westpac Securities Limited, ABN 39 087 924 221, AFSL 233723 (“Westpac Securities”) and Australian
Investment Exchange Limited, ABN 71 076 515 930, AFSL 241400 (“AUSIEX”) is current as at 15 February 2023.

Australian Securities trading through Westpac Share Trading is a service provided through Westpac Securities by AUSIEX. AUSIEX is a Market Participant of the Australian
Securities Exchange Limited (“ASX Limited”) and Cboe Australia Pty Ltd (“Cboe”), a Clearing Participant of ASX Clear Pty Limited and a Settlement Participant of ASX
Settlement Pty Limited. AUSIEX is not authorised to carry on business in any jurisdiction other than Australia. Accordingly, the information contained in this document is
directed to and available for Australian residents only. You should read the Westpac Securities and AUSIEX Financial Services Guides (“FSGs”), which provide you with
information on the services Westpac Securities and AUSIEX can provide. You can access the FSGs via westpac.com.au/personal-banking/share-trading. All examples and
images are for illustrative purposes only. Your portfolio value and performance are likely to be different and will depend on the investment options you have selected and
the time period over which you are invested in those options. Past performance is not a reliable indicator of future performance. The information has been prepared without
taking account of your objectives, financial situation or needs. For this reason, before acting on the information you should consider whether it is appropriate to you, having
regards to your objectives, financial situation and needs and, if necessary, seek appropriate financial advice.

The Westpac Cash Investment Account and Westpac Cash Facility is issued by Westpac Banking Corporation ABN 33 007 457 141, AFSL and Australian credit licence
233714. Please read the Westpac Cash Investment Account Terms and Conditions and consider if a Westpac Cash Investment Account is suitable for you. A Target Market
Determinations for the product is available at westpac.com.au/tmd > Enter what you are looking for > Type in Cash Investment Account.

Westpac Securities Limited is a subsidiary of Westpac Banking Corporation (“Westpac”) and part of the Westpac Group. A financial product acquired through Westpac
Securities is not a deposit with, or any liability of, Westpac or any other company in the Westpac Group. Westpac doesn’t guarantee the obligations of its subsidiaries or the
products or services its subsidiaries offer.

© Westpac Banking Corporation ABN 33 007 457 141 AFSL and Australian credit licence 233714. The Westpac Group, 275 Kent Street, Sydney, NSW 2000, AUSTRALIA.
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